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Welcome

This documentation shows you how ArchestrA Integrated 
Development Environment (IDE) can manage InTouch HMI 
applications so that you can effectively use the new functionality 
introduced by the ArchestrA Symbol Editor. 

You can view this document online or you can print it, in part or whole, 
by using the print feature in Adobe Acrobat Reader.

This documentation assumes you know how to use Microsoft Windows, 
including navigating menus, moving from application to application, 
and moving objects on the screen. If you need help with these tasks, 
see the Microsoft documentation. 

Documentation Conventions
This documentation uses the following conventions:

Convention Used for

Initial Capitals Paths and file names.

Bold Menus, commands, dialog box names, and 
dialog box options.

Monospace Code samples and display text.



8    Welcome

InTouch HMI and ArchestrA Integration Guide

Technical Support
Wonderware Technical Support offers a variety of support options to 
answer any questions on Wonderware products and their 
implementation.

Before you contact Technical Support, refer to the relevant section(s) 
in this documentation for a possible solution to the problem. If you 
need to contact technical support for help, have the following 
information ready:

• The type and version of the operating system you are using.

• Details of how to recreate the problem.

• The exact wording of the error messages you saw.

• Any relevant output listing from the Log Viewer or any other 
diagnostic applications.

• Details of what you did to try to solve the problem(s) and your 
results.

• If known, the Wonderware Technical Support case number 
assigned to your problem, if this is an ongoing problem.
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Chapter 1

About InTouch HMI and
ArchestrA Integration

You can manage your InTouch applications with the InTouch 
Application Manager or with the ArchestrA IDE. 

There are three types of InTouch applications, categorized by how they 
are managed or where they were published from:

You can enhance your InTouch applications with graphic objects, the 
ArchestrA Symbols. 

Stand-Alone InTouch Applications 
Stand-alone InTouch applications are managed by the InTouch 
Application Manager.

They appear in the InTouch Application Manager as Stand Alone. 

Stand-Alone InTouch applications

Managed InTouch applications

Published InTouch applications
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Using the Application Manager, you can: 

• Create and manage stand-alone InTouch applications.

• Start WindowMaker to edit InTouch applications

• Start WindowViewer to run InTouch applications.

You can also switch directly between WindowMaker and 
WindowViewer to test or run your applications and switch back to 
make modifications to your applications. 

Network Application Development manages the propagation of 
changes from your InTouch application on a development node to 
running InTouch applications on target nodes. 

Application Manager
(manages InTouch Applications)

WindowMaker
(edits InTouch Applications)

WindowViewer
(tests InTouch Applications)

STARTS STARTS

FAST
SWITCH

Development

Application Manager
(manages InTouch Applications)

WindowViewer
(runs InTouch Applications)

STARTS

Target Nodes

Propagation

Network 
Application 

Development
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Communication within the Galaxy
ArchestrA enables the use of a Galaxy-wide name space to contain and 
process production-related data. It also allows a high-level 
visualization and administration of data access from various nodes 
running InTouch in the manufacturing environment.

Managed InTouch Applications 
You can manage your InTouch applications using the ArchestrA 
Integrated Development Environment (IDE). These applications are 
called “Managed” InTouch applications. 

They appear in InTouch Application Manager as Managed. 

You develop an InTouch application on one node of the Galaxy with 
WindowMaker. You then deploy it to one or more target nodes running 
WindowViewer. 

ArchestrAInTouch

Application Manager

WindowMaker WindowViewer

Development

Application Manager WindowViewer

Target Nodes

Propagation

Network 
Application 
Development

Bootstrap
&

WinPlatform

Galaxy Name Space
(ArchestrA Attributes)

Bootstrap
&

WinPlatform

Communication
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When you use the system platform functionality of the ArchestrA IDE 
to manage your InTouch applications, you can:

• See which InTouch applications are running on what node. 

• Use a central repository for InTouch applications.

• Deploy changes to WindowViewer running on the remote nodes.

Published InTouch Applications
After you edit your managed InTouch application, you can publish it.

A published application appears in InTouch Application Manager as 
Published.

The advantage of published InTouch applications is that they can be 
distributed like stand-alone InTouch applications, but continue to 
support the functionality of ArchestrA Symbols. 

However, you can no longer:

• Use ArchestrA IDE to deploy InTouch applications.

• Edit or add ArchestrA Symbols in InTouch applications.

ArchestrAInTouch

WindowMaker

Development

Application Manager WindowViewer

Target Nodes

Bootstrap
&

WinPlatform

Galaxy Name Space
(ArchestrA Attributes)

&
InTouch Application 

Management

Bootstrap
&

WinPlatform

Communication
& Deployment

Configuration
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ArchestrA Symbol Editor
In addition to the benefits of managing InTouch applications within 
the ArchestrA IDE, you can model your manufacturing environment 
by creating graphics with the ArchestrA Symbol Editor. The 
ArchestrA Symbol Editor is fully integrated into the ArchestrA IDE 
and supports powerful graphics editing capabilities.

The ArchestrA Symbol Editor includes the ability to apply an Element 
Style to a symbol element. An Element Style is a defined set of visual 
properties for text, element fill, element outlines, and lines that are 
applied to graphic elements. Using Element Styles makes it easy to 
apply standard visual styles to graphic elements and establish 
consistent symbol standards.

The ArchestrA Symbol Editor also includes the Symbol Wizard Editor, 
which enables you to create Symbol Wizards containing different 
visual and functional configurations. Using the Symbol Wizard Editor, 
you can, for example, create a configurable ArchestrA pump symbol 
with separate left and right inlet valve configurations. Situational 
Awareness Library symbols are examples of Symbol Wizards 
containing pre-built configurations that are selected by choosing from 
the symbol’s Wizard Options. A single Situational Awareness Library 
symbol can be easily configured to represent a thermometer, a flow 
meter, or a pressure meter. You select the configuration you need 
when the Symbol Wizard is embedded in a managed InTouch 
application.

WindowMaker incorporates the ArchestrA Graphic Toolbox to select 
ArchestrA and Situational Awareness Level symbols for InTouch 
applications without opening the ArchestrA Symbol Editor. Symbols 
can be added by dragging and dropping them directly from 
WindowMaker into an InTouch window. For more information about 
working with ArchestrA and Situational Awareness Level symbols, see 
the Creating and Managing ArchestrA Graphics User’s Guide or 
WindowMaker help.

Note:  In recent versions of Microsoft’s rendering technologies, certain 
gradient features have been deprecated. To accommodate and future 
proof graphics built using ArchestrA, the affected features have been 
removed from the configuration environment. Graphics previously 
configured with deprecated features will continue to render as 
expected. See "Loading Graphics with Deprecated Features" from 
Chapter 6, "Editing Common Properties of Elements and Symbols," in 
the Creating and Managing ArchestrA Graphics User’s Guide.
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Comparing Stand-Alone, Managed, and Published 
InTouch Applications

Stand-alone, managed, and published InTouch applications have some 
differences and some similarities, as described in the following table: 

Stand-alone 
InTouch 
Applications

Managed InTouch 
Applications

Published 
InTouch 
Applications

Create 
Application

Application 
Manager

ArchestrA IDE

• New application

• Importing stand-alone 
application

• Importing SmartSymbols

Not possible

Edit Application WindowMaker 
started from the 
Application 
Manager

WindowMaker started from 
within the IDE

WindowMaker 
started from the 
Application 
Manager

Delete 
Application

Remove from 
Application 
Manager. 

Delete InTouchViewApp 
template

Remove from 
Application 
Manager. 

Support of 
ArchestrA 
Symbols, 
including Symbol 
Wizards

No Yes for all operations Yes, but only for 
viewing, not for 
creating and 
editing

Support of DB 
Dump and DB 
Load

Yes, function within 
Application 
Manager

Yes, function within the IDE Yes, function 
within Application 
Manager

Editing 
application in 
original 
resolution 
requires 
conversion

Yes No Yes

Management of 
Distributed 
Applications

Network 
Application 
Development (NAD)

ArchestrA IDE Network 
Application 
Development 
(NAD)
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Managing InTouch Applications Using the 
ArchestrA IDE

You can manage your InTouch applications using the IDE. The 
following procedure shows you how to do this in a general way. For 
more specific information, see "Managing InTouch Applications with 
the IDE" on page 31.

The InTouch functionality in the ArchestrA IDE is handled by two 
AutomationObjects:

• The InTouchViewApp object represents an InTouch application at 
design time and run time.

• The ViewEngine object controls how an InTouch application runs 
on a target node in a Galaxy.

Configuring how 
new InTouch 
application 
versions are 
accepted

Configured in 
Application 
Manager (Network 
Application 
Development)

Configured in WindowMaker Configured in 
Application 
Manager (Network 
Application 
Development)

Use Fast-Switch 
to test 
application

Yes Yes Yes

Use tag value 
and tag 
parameter 
retention

Yes Yes, also requires 
configuration of the local 
working directory

Yes

Stand-alone 
InTouch 
Applications

Managed InTouch 
Applications

Published 
InTouch 
Applications
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The following diagram shows how InTouch applications are managed 
using the ArchestrA IDE:

To use the IDE to manage your InTouch applications

1 Create a managed InTouch application in the ArchestrA IDE.

2 Open it in WindowMaker.

3 Configure your InTouch application in WindowMaker. You can 
switch to WindowViewer to test the application. 

4 Save the InTouch application and close WindowMaker and 
WindowViewer.

5 Determine which nodes to deploy the InTouch application to.

6 Deploy the InTouch application to the target nodes in the Galaxy. 

7 Run the InTouch application in WindowViewer on the target 
nodes. 

Development NodeArchestrA IDE

WindowMaker WindowViewer

Derive

Derive

Target Node

Deploy

Close (Check In)

Develop, modify and 
test InTouch 
Application

Open (Check Out)

WindowViewerApplication 
Manager

Run InTouch 
Application in 
WindowViewer

$InTouchViewApp
base template

$MyInTouchApp
derived template

MyInTouchApp_001
instance

1

2

3

4

5

6

7
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InTouchViewApp Object
ArchestrA manages your InTouch applications with a specific type of 
ArchestrA object called the InTouchViewApp object. 

An InTouchViewApp template references one specific managed 
InTouch application at design time and cannot be executed at run 
time.

You must create an instance of the InTouchViewApp template. This 
instance can be deployed to a target node. The target node is the node 
on which the managed InTouch application runs in WindowViewer. 

To distribute an InTouch application, you create multiple instances of 
the same template and deploy them to multiple nodes. 

Optionally, you can:

• Export and import the InTouchViewApp object to exchange 
managed InTouch applications across Galaxies. 

• Export and import tag dictionary data as .csv files. 

• Export and import windows between different types of InTouch 
applications.

• Publish the managed InTouch application. The published InTouch 
application runs like a stand-alone InTouch application but can 
contain ArchestrA Symbols.

• Use the attributes of the deployed InTouchViewApp object to read 
from and write to InTouch tags with ArchestrA attributes. 

To use the InTouchViewApp object

1 Derive an InTouchViewApp template from the $InTouchViewApp 
base template.

2 Associate the derived template with an InTouch application by 
creating a new InTouch application or importing a stand-alone 
InTouch application.

3 Open the application in WindowMaker. 

4 Configure the application in WindowMaker and test it in 
WindowViewer. 

5 Save and close WindowMaker. The InTouchViewApp template is 
checked in.

6 Derive instances from the InTouchViewApp template. 

7 Deploy these instances to selected target nodes within the Galaxy.

8 Run Application Manager on the target nodes and run the 
managed InTouch applications in WindowViewer. 
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Associating a InTouchViewApp Template with an 
InTouch Application

After you create a new InTouchViewApp template, you can associate 
an InTouchViewApp template with an InTouch application by: 

• Creating a new InTouch application.

• Importing a stand-alone InTouch application.

The InTouchViewApp template does not contain the InTouch 
application data itself, such as the tag configuration and values, but 
simply references the application. 

Editing a Managed InTouch Application
You edit a managed InTouch application with WindowMaker as you do 
for a stand-alone InTouch application, except that you open the editor 
of the InTouchViewApp template to start the associated InTouch 
application in WindowMaker.

When you close WindowMaker after making changes to the InTouch 
application, the InTouchViewApp object is automatically checked in.

Testing a Managed InTouch Application
You can test a managed InTouch application with WindowViewer as 
you can with stand-alone InTouch applications. 

You can fast switch between WindowMaker and WindowViewer to test 
a managed application if you opened WindowMaker from the 
ArchestrA IDE.

If a managed InTouch application contains references to ArchestrA 
data, such as galaxy:UDA, then a WinPlatform object needs to be 
deployed to the node you are editing the InTouch application on. 
Otherwise, the data shows blank values.
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Deploying the InTouchViewApp Object
After you derive an instance of your InTouchViewApp template, you 
can assign it to the target platform under a ViewEngine object. 

You cannot assign multiple InTouchViewApp instances that have the 
same parent under one ViewEngine. Instead create a second 
ViewEngine instance to host additional InTouchViewApp instances 
with the same parent.

After you deploy the InTouchViewApp object, you can open the 
InTouch Application Manager on the target node. The associated 
managed InTouch application appears in the list together with the 
time stamp of its last deployment in the Date Modified column. 

When you deploy the InTouchViewApp instance to a target node, the 
InTouch application is contained in:

• A folder on the development node. This contains the source for the 
InTouchViewApp template.

• A folder on the target node from which the InTouch application 
runs. This contains an instance copy of the InTouch application.

Exporting and Importing an InTouchViewApp 
Object

You can export the InTouchViewApp object. You do this, for example, 
to use the managed InTouch application together with its hosting 
InTouchViewApp object in other Galaxies.

When you export the object, a package file (.aaPKG) is created 
containing information about the object, the associated managed 
InTouch application, and any ArchestrA Symbols the application uses.

When you import an InTouchViewApp object, the ArchestrA IDE also 
imports the managed InTouch application. 
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Exporting and Importing Tag Data Associated with 
a Managed InTouch Application

You can export tag data that is associated with a managed InTouch 
application to a .csv file. This is equivalent to the DB Dump function of 
the InTouch Application Manager.

You can import the exported tag data from a .csv file back into a 
managed InTouch application in the same way as the DB Load 
function. 

The exported .csv files from a managed InTouch application and those 
of a stand-alone InTouch application are fully interchangeable. 

Publishing Managed InTouch Applications 
You can publish a managed InTouch application. The published 
InTouch application is no longer associated with the InTouchViewApp 
template. 

The published application cannot be edited within the IDE or imported 
into another InTouchViewApp template. In other words, you cannot 
manage it with the IDE or republish it. 

The published InTouch application can still communicate with the 
Galaxy through any embedded ArchestrA Symbol. You can, for 
example, write data back to the Galaxy or visualize Galaxy data. 

You can edit the ArchestrA Symbol using basic InTouch operations 
such as copying, cutting, pasting, duplicating, moving, resizing, 
flipping, rotating, and configuring with InTouch animation links. 

However, the ArchestrA Symbols cannot be modified, nor can new 
ArchestrA Symbols be embedded into the InTouch application. These 
operations are only allowed with managed InTouch applications. 

You can do this in environments that do not support the processing 
requirements of ArchestrA. For example, in remote plant operations or 
in small networks.
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Exporting and Importing InTouch Windows between 
InTouch Applications

You can export windows from all three InTouch application types from 
WindowMaker, but there are some restrictions on importing exported 
windows or windows directly from an InTouch application.

• For stand-alone InTouch applications, you cannot import any 
windows from published and managed InTouch applications that 
contain ArchestrA Symbols. A warning message appears, and 
information on which windows were not imported is written to the 
Logger. 
If you import windows from managed or published InTouch 
application that contain ArchestrA Symbols, the windows are 
imported, but the ArchestrA Symbols are not functional and 
appear as “Not Found”.

• For managed InTouch applications, you can import any windows 
from published, stand-alone, and other managed InTouch 
applications. Embedded ArchestrA Symbols are not imported.

• For published InTouch applications, you can import any windows 
from stand-alone InTouch applications. Embedded ArchestrA 
Symbols are not imported. 

Attributes of the InTouchViewApp Object
You can use the ArchestrA attributes of the InTouchViewApp object to 
access the run-time data of the tags of the associated InTouch 
application. This is useful for reading and writing InTouch data 
directly in the Galaxy name space and provides the same functionality 
as the InTouchProxy object. 

In this example, a deployed managed InTouch application uses a real 
tag TankLevel to report the fill level of a tank and a discrete tag 
ValveOut to control the state of a valve.

To read and write the InTouch tags from the 
InTouchViewApp object instance

1 Right-click the deployed InTouchViewApp object, and then click 
View in Object Viewer. Object Viewer appears.

2 Right-click in the Watch area, and then click Add Attribute 
Reference. The Add Attribute Reference dialog box appears.

3 In the Attribute Reference box, type the name of the 
InTouchViewApp object followed by a dot and the name of the 
InTouch tag you want to read or write. For example, 
TankDemo_001.TankLevel.

4 Click OK. The attribute is added to the Watch area.
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5 Repeat steps 2 through 4 for any other InTouch tags you want to 
read or write.

6 You can now view the InTouch tag value.

7 To write to an InTouch tag value, do the following:

a Double-click it. The Modify Value dialog box appears.

b Type a new value and click OK. The value is written back to the 
tag of the running InTouch application.

Differences Between the InTouchViewApp Object 
and Other AutomationObjects

The InTouchViewApp object is unlike other AutomationObjects. You 
cannot perform some operations you can normally do with other 
AutomationObjects. 

• If you try to configure an InTouchViewApp instance, a message 
appears asking if you want to open its parent template instead. 
You cannot configure the instance directly, only the parent 
template.

• If you try to open more than one InTouchViewApp template for 
configuration at a time on one node, IDE prevents you from doing 
so. Close WindowMaker, WindowViewer, and Application Manager 
and retry. Alternately, you can edit the InTouchViewApp object on 
a different node with InTouch WindowMaker. 

• If you close the IDE while editing an InTouch application with 
WindowMaker, WindowMaker prompts you to save any changes. It 
then closes and the InTouchViewApp template is checked in. 

• If you close the IDE while testing an InTouch application with 
WindowViewer, WindowViewer closes. 

If you want to:

• Change the association between the InTouchViewApp and the 
InTouch application, create a new derived InTouchViewApp 
template instead.

• Use ArchestrA security (Galaxy security) in InTouch, deploy a 
WinPlatform instance to the node on which the deployed managed 
InTouch application is running.
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ViewEngine Object
The ViewEngine is an ArchestrA object that hosts and runs deployed 
InTouchViewApp objects. 

To deploy an InTouchViewApp instance to a target platform, you need 
to assign it to a ViewEngine object first. The ViewEngine object is then 
assigned to the target WinPlatform object. 

The ViewEngine fulfils the same functions for the InTouchViewApp 
instances as the AppEngine instance does for the Application Objects. 
The ViewEngine: 

• Sets up and initializes the InTouchViewApp objects when they are 
initially deployed and started, so that they can communicate with 
other objects in the Galaxy.

• Performs diagnostics on attributes that can be monitored, alarmed, 
and historized.

• Historizes data to the Wonderware Historian.

You can use different ViewEngine objects to:

• Historize data to different Wonderware Historians.

• Interact with deployed InTouch applications at different scan 
rates. This sets at which frequency InTouch tag data can interact 
with the Galaxy name space.

A platform can host multiple ViewEngine objects. Every 
InTouchViewApp must be assigned to a ViewEngine. 

You cannot create multiple instances of the same InTouchViewApp 
template to run under the same ViewEngine object. But you can run 
multiple instances of the same template under different ViewEngine 
objects. 
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ArchestrA Symbols
The ArchestrA IDE includes a Symbol Editor to create symbols that 
represent production processes and provide an HMI interface to 
ArchestrA AutomationObjects. 

The following diagram shows how symbols that are created with the 
ArchestrA Symbol Editor can be used in InTouch applications.

Creating ArchestrA Symbols
ArchestrA Symbols are created with the ArchestrA Symbol Editor in 
the IDE.

You can create:

• ArchestrA Symbols in the Graphic Toolbox. These are not 
associated with any specific ArchestrA object template or 
ArchestrA object instance.

• ArchestrA Symbols contained in a specific ArchestrA object 
template or instance.
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Embedding ArchestrA Symbols into InTouch 
Windows

ArchestrA Symbols can be embedded into a managed InTouch 
application and used. 

You can embed an ArchestrA Symbol into a window of a managed 
InTouch application from:

• The Graphic Toolbox

• An ArchestrA object template

• An ArchestrA object instance

You embed these objects into InTouch windows by browsing the 
Galaxy for symbols or AutomationObjects.

Creating New ArchestrA Object Instances 
Automatically

If you embed an ArchestrA Symbol from a template, the InTouch HMI 
can create an instance of that object and the symbol instance 
references the new instance. 

The following example shows you how to create a new ArchestrA object 
instance automatically.

To create a new ArchestrA object instance automatically

1 Create an ArchestrA object template $Valve1 and open it in the 
ArchestrA IDE object editor.
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2 On the Graphics tab, add an ArchestrA Symbol called 
ValveSymbol. 

3 Create a derived template of the InTouchViewApp object and open 
it in WindowMaker.

4 Create a new InTouch window and embed the ArchestrA Symbol 
ValveSymbol from the ArchestrA object template $Valve1. 
WindowMaker prompts you for an instance name.

5 Type a name, for example Valve1_E122 and click OK. The 
ArchestrA Symbol is pasted on the InTouch window and the 
AutomationObject instance Valve1_E122 is created in the Galaxy.

Exporting and Importing ArchestrA Graphics as 
XML Files

Use the ArchestrA GraphicAccess application programming interface 
(API) to export an existing ArchestrA graphic to an XML file. Use the 
same API to create an ArchestrA graphic in another galaxy or to 
overwrite an existing graphic by importing the graphic definition from 
an XML file.

Before using the ArchestrA GraphicAccess API, you must use the 
ArchestrA GRAccess Toolkit to log in and connect to an ArchestrA 
Galaxy Repository. For more information about logging in and 
connecting to a Galaxy repository, see the GRAccess Toolkit API User’s 
Guide.

Creating Symbol Wizards with the Symbol 
Wizard Editor

The ArchestrA Symbol Editor includes the Symbol Wizard Editor, 
which can be used to create different visual and functional 
configurations of a symbol. These multi-configuration symbols are 
called Symbol Wizards. An example of creating a Symbol Wizard is a 
pump symbol that shows the outlet pipe on the left or right of the 
central blade housing. Using the Symbol Wizard Editor, both 
configurations can be included in one Symbol Wizard.
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Symbols Wizards are not associated with any specific ArchestrA object 
template or ArchestrA object instance. Except for the ability to select a 
specific symbol configuration, Symbol Wizards behave like standard 
ArchestrA Symbols.

The ability to create Symbol Wizards with different configurations 
reduces the number of required symbols that need to be created for an 
application. Also fewer symbols results in lower maintenance and 
fewer design time issues.

Creating Symbol Wizards
The process of creating and implementing a Symbol Wizard has two 
work flows, a Designer workflow and a Consumer work flow:

• A Designer creates multiple configurations of a symbols using the 
Symbol Wizard Editor.

• A Consumer selects the appropriate configuration of a Symbol 
Wizard and embeds the symbol into managed InTouch 
applications.

Symbol Wizard Designer Workflow
The Designer uses the Symbol Wizard Editor to define the various 
symbol configurations and assign graphic elements, custom properties, 
and scripts to symbol configurations in the form of layers. Rules are 
assigned with Choice Groups, Choices, and Options that determine 
when a layer is included in a symbol configuration. The Designer 
selects a configuration to be the symbol default that appears when the 
symbol is embedded in a managed InTouch application.
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After creating all symbol configurations, the Designer verifies how 
each configuration of a symbol will be presented to a Consumer using 
the Symbol Wizard Preview. Designers use the Wizard Options to 
verify that each configuration appears as designed based on the layer 
rules set for the symbol.

When a Symbol Wizard is finished, the Designer saves it to the Galaxy 
library so that it is available to embed into managed InTouch 
applications.

For more information about creating Symbol Wizards, see Chapter 17 
of the ArchestrA Graphic Editor User’s Guide.

Symbol Wizard Consumer Workflow
When a Consumer embeds an instance of a Symbol Wizard into a 
managed InTouch application, the symbol’s default configuration is 
selected. The Consumer can change the configuration by selecting 
options from the Symbol Wizard’s Wizard Options view. Depending on 
the selected configuration, there can be additional 
configuration-related properties that can be selected by the Consumer.

While the InTouch application is running, the Symbol Wizard appears 
as the configuration selected by the Consumer. A symbol’s 
configuration cannot be changed during run-time.

For more information about how to embed Symbol Wizards into a 
managed InTouch applications, refer to "Embedding Symbol Wizards" 
on page 52.
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Symbol Change Propagation
Any changes to a source ArchestrA Symbol are propagated to all 
embedded ArchestrA Symbols. This affects the ArchestrA Symbols in 
WindowMaker and the ArchestrA Symbols inherited by 
AutomationObjects. 

If a change is made to an ArchestrA Symbol and it is used in an open 
InTouch window, the Symbol Changed icon appears in the bottom 
right corner of the status bar. 

When you double-click this icon, the embedded ArchestrA Symbol is 
updated with the changes. 

The following example shows you how symbol change propagation 
works.

To propagate a symbol change

1 Follow the example from "Creating New ArchestrA Object 
Instances Automatically" on page 25.

2 In WindowMaker, open the window that shows the Valve symbol.

3 Open the ArchestrA Symbol ValveSymbol that is hosted by the 
ArchestrA object template $Valve1.

4 Make some changes and click Close and Save. The changes are 
propagated to ArchestrA object instance Valve1_E22. In 
WindowMaker, the Symbol Changed icon appears.

5 Double-click the icon to accept the changes. The embedded 
ArchestrA Symbol is updated.

Symbol Dynamic Size Propagation
You can control the way that size changes of the source symbol are 
propagated to its embedded symbols. For example, a size change is:

• Resizing one of the elements in the source symbol so that the 
symbol boundary changes.

• Adding elements to or removing elements from the source symbol 
so that the symbol’s boundary changes.

This feature is called dynamic size change propagation and can be 
enabled or disabled.

For more information about dynamic size propagation, see the 
Creating and Managing ArchestrA Graphics User’s Guide.
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Chapter 2

Managing InTouch
Applications with the IDE

You can use the ArchestrA IDE to:

• Create a new managed InTouch application.

• Import an existing InTouch application to use as a managed 
InTouch application.

• Start WindowMaker.

• Submit the changes you make in WindowMaker to a managed 
InTouch application. 

• Export and import a managed InTouch application together with 
its InTouchViewApp object.

• Publish a managed InTouch application. 

• Delete a managed InTouch application. 

• Import and export tag data used in a managed InTouch 
application.

• Export tag data to and import tag data from a .csv file.

• Switch languages for a Managed InTouch application.

• Add files to a Managed InTouch application.

• Associate all Galaxy graphics with an InTouchViewApp.

You can start the ArchestrA IDE from the InTouch Application 
Manager.
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The following graphic shows how applications are imported, exported, 
managed, and published.

Starting the ArchestrA IDE from Application 
Manager

If ArchestrA IDE is installed on the same computer as InTouch, you 
can easily start the ArchestrA IDE from the InTouch Application 
Manager.

To start the ArchestrA IDE from Application Manager

 In the InTouch Application Manager, do one of the following:

• On the File menu, click ArchestrA IDE.

• Click the ArchestrA IDE icon on the toolbar.

The Connect to Galaxy dialog box appears.
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Creating a Managed InTouch Application
You create a managed InTouch application by creating and configuring 
an InTouchViewApp object. 

You can also view application version, resolution, and description 
information directly from the InTouchViewApp object. 

The InTouch application directory is created as a share:

\\GRNodeName\GalaxyName-$InTouchViewAppObjectName

This directory is managed by the IDE, not by the InTouch Application 
Manager. 

To create a managed InTouch application 

1 Open the ArchestrA IDE.

2 In the Template Toolbox, expand the System toolset.

3 Derive a template from the $InTouchViewApp base template. Do 
the following:

a Right-click the $InTouchViewApp base template, point to 
New, and then click Derived Template. A new derived 
template appears with a default name.

b Rename the new template if needed.

4 Double-click the derived template. The InTouchViewApp 
Initialization dialog box appears.
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5 Select Create New InTouch Application and click Next. The next 
panel appears.

6 Type a name for the InTouch application and a description. 

7 Select InTouchView Application to create an InTouch application 
that uses only ArchestrA references as an external data source.

8 Click Next. WindowMaker starts.

To view application version, resolution, and description

1 Open the Template Toolbox.

2 Right-click the InTouchViewApp template, and then click 
Application Information. The Application Information dialog box 
appears.
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Starting WindowMaker from the ArchestrA IDE
You can edit a managed InTouch application by starting 
WindowMaker from within the ArchestrA IDE. 

You can start WindowMaker from an InTouchViewApp template or an 
instance.

When opening a managed InTouch application created with a different 
screen resolution than your current system resolution, a message 
appears.

• Click Yes to convert the InTouch application to the current system 
resolution and open it.

• Click No to open and edit the InTouch application in its original 
resolution. 

To start WindowMaker from an InTouchViewApp template

1 Open the ArchestrA IDE.

2 Locate the InTouchViewApp template that includes the managed 
InTouch application you want to modify. 

3 Double-click the InTouchViewApp template. WindowMaker starts 
as the object’s default editor and opens the InTouch application. 
You are ready to edit the managed application.

To start WindowMaker from an InTouchViewApp instance

1 Open the ArchestrA IDE.

2 Locate the InTouchViewApp object whose parent hosts the 
managed InTouch application you want to modify. 
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3 Double-click the InTouchViewApp object. The InTouchViewApp 
Instance Edit dialog box appears.

4 Do any of the following:

• Click No to not open the template.

• Click Yes to open the associated InTouchViewApp template in 
WindowMaker.

If you select the Don’t ask me again check box and click Yes, 
the next time you open an InTouchViewApp instance, the 
managed InTouch application is automatically opened from the 
associated InTouchViewApp template. 

You can change this setting using the Configure User 
Information dialog box, which you open from the Edit menu.

Submitting Changes for an InTouch Application
After you modify your managed InTouch application, you can submit 
the changes for deployment to the target nodes. 

After you make changes to a managed InTouch Application, any 
derived InTouchViewApp objects appear with the Pending Changes 
icon. 

This indicates that you must redeploy the changes to the target nodes, 
for WindowViewer on those nodes to reflect the changes. 

For more information on how to deploy the changes to the operator 
nodes, see "Deploying a Managed InTouch Application" on page 73 and 
"Accepting New Application Versions at the Operator Node" on 
page 76.
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To submit the changes for an InTouch application 

1 Modify your managed InTouch application in WindowMaker as 
you would with a stand-alone InTouch application.

2 Save your InTouch windows.

3 On the File menu, click Exit. WindowMaker closes and the focus 
returns to IDE. The Check In dialog box appears.

4 Type a comment for check in, if necessary and click OK. The Check 
In progress dialog box appears. 

5 Click Close.

Importing an InTouch Application
You can import an existing InTouch application to use as a managed 
InTouch application. You do this in two steps:

• Create an InTouchViewApp object to associate with the imported 
InTouch application. 

• Import the InTouch application.

The imported InTouch application becomes a managed InTouch 
application. 

The ArchestrA IDE creates a copy of the existing InTouch application 
in a folder that it manages. The IDE leaves the existing InTouch 
application and location unchanged.

If the version of the InTouch application you are importing is 6.0 or 
above, a conversion message appears. The application is converted 
before it is opened in WindowMaker. InTouch applications versions 
before 6.0 cannot be converted.

To import an InTouch application into a Galaxy

1 Open the ArchestrA IDE.

2 In the Template Toolbox, derive a template from the 
$InTouchViewApp base template. 

3 Open the derived template. The InTouchViewApp Initialization 
dialog box appears.
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4 Click Import Existing Application and click Next. The next panel 
appears.

5 Locate the InTouch application. Do any of the following:

• Click the ellipsis button to browse for the folder that contains 
the managed InTouch application.

• To search for the application, select the Find applications 
check box. Specify a search root for the search to begin and 
click Find. Select the InTouch application from the list.

6 Click Next. The next panel appears.

7 If needed, type a new name in the Application Name box and a 
description in the Description box. The name and description 
appear in the Application Manager when the managed InTouch 
application is deployed.
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8 Click Next. The next panel appears and shows you the import 
progress.

9 Click Close. InTouch WindowMaker is started and you can edit the 
InTouch application as a managed InTouch application.

Importing and Exporting an InTouchViewApp 
Object

You can import and export the InTouchViewApp object in the 
ArchestrA IDE. The InTouchViewApp object contains all information 
for hosting a managed InTouch application and can be used to 
exchange a managed InTouch application between Galaxies. 

For more information about importing and exporting 
AutomationObjects, see the Wonderware Application Server 
documentation. 

To import an InTouchViewApp object

1 On the Galaxy menu, point to Import, and then click Object(s). 
The Import Automation Object(s) dialog box appears.

2 Select the ArchestrA package (.aaPKG) file that contains the 
InTouchViewApp object you want to import and click Open. The 
object and its managed InTouch application are imported.

3 Click Close. 

To export an InTouchViewApp object

1 On the Galaxy menu, point to Export, and then click Object(s). 
The Export Automation Object(s) dialog box appears. 

2 Select a folder to export to, specify an ArchestrA package (.aaPKG) 
file name and click Save. The object and its managed InTouch 
application are exported. 

3 Click Close.
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Publishing a Managed InTouch Application
You can publish a managed InTouch application from the 
InTouchViewApp object that is associated with it. 

The export consists of a folder containing information about the object 
and the managed InTouch application. 

This is different than exporting the InTouchViewApp object itself. For 
more information, see "Importing and Exporting an InTouchViewApp 
Object" on page 39. 

The published InTouch application cannot be reimported into an 
InTouchViewApp object.

To publish a managed InTouch application 

1 Open the ArchestrA IDE.

2 Locate the InTouchViewApp object that contains the managed 
InTouch application you want to publish.

3 Right-click the object, and then click Publish InTouch Application. 
The Browse For Folder dialog box appears.

4 Specify the folder to publish to the InTouch application to. Do any 
of the following: 

• Browse to an existing folder.

• Click Make New Folder to create a new folder or folder 
structure.
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5 Click OK. The Publish InTouch Application progress dialog box 
appears.

6 When publishing is complete, click Close. A directory containing 
the new published InTouch application is created in the selected 
folder. You can now copy it to any run-time node.

Deleting a Managed InTouch Application
You can delete an InTouch application in the ArchestrA IDE by 
deleting the associated InTouchViewApp template.

When you do this, the template and the InTouch application directory 
associated with that template are deleted completely. 

You can only delete an InTouch application if the associated 
InTouchViewApp object does not have any derived instances.

Deleting an InTouchViewApp instance does not delete the associated 
InTouch application. 

To delete the InTouchViewApp template

1 Open the ArchestrA IDE.

2 Select the InTouchViewApp template that contains the managed 
InTouch application you want to delete.

3 On the Edit menu, click Delete. The Delete dialog box appears.

4 Click Yes. The InTouchViewApp template and the associated 
InTouch application folder are deleted.
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Exporting and Importing Tag Data
You can export the tag data of a managed InTouch application to a .csv 
file. You can import this data into another managed InTouch 
application or a stand-alone InTouch application.

To export tag data from a managed InTouch application

1 Open the ArchestrA IDE.

2 Select the derived InTouchViewApp template that contains the 
managed InTouch application from which you want to export the 
tag data.

3 On the Galaxy menu, point to Export, and then click DB Dump. 
The CSV File to Dump To dialog box appears. 

4 Specify a location and file name for the .csv file and click Save. A 
confirmation dialog box appears. 

5 Select Group output by types if you want the tag data to be 
grouped by data types in the .csv file. 

6 Click OK. When a success message appears, click OK. 

To import tag data from a .csv file to a managed InTouch 
application

1 Open the ArchestrA IDE.

2 Select the derived InTouchViewApp template that contains the 
managed InTouch application to which you want to import the tag 
data.

3 On the Galaxy menu, point to Import, and then click DB Load. The 
CSV File to Load From dialog box appears. 

4 Select the .csv file and click Open. 
During the import, one or more messages may appear warning you 
of duplicate names. Select the appropriate option for each 
duplicate tag. 

5 When a success message appears, click OK. 
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Retaining Tag Value and Parameters
When you use multiple managed InTouch applications on one node, all 
applications use the same directory. If you configure tag data or 
parameters to be retained and you switch applications, the run-time 
data is lost. 

To configure retention in a managed InTouch application

1 Open the managed InTouch application with WindowMaker from 
the IDE.

2 On the Special menu, point to Configure, and then click 
WindowViewer. The WindowViewer Properties dialog box 
appears. 

3 Click the Managed Application tab.

4 In the Local Working Directory box, type the name of a unique 
existing directory. This is the name of the directory on the target 
run-time node. You can also use special characters to specify the 
local working directory path. The following table illustrates the 
special characters that you can use:

Special Character Local Working Directory Path

%SystemDrive% System drive. For example, "C:"

%USER% Name of the logged-on user. If 
WindowViewer is running as a service, 
the application is copied to "All Users" 

%APPDATA% Logged-on user's Application Data. If 
WindowViewer is running as a service, 
the application is copied to "All Users" 
Application Data 

%ITUSER% Logged-on user. If WindowViewer is 
running as a service or in a console 
session, the application is copied to "All 
Users" 

%ITAPPDATA% Logged-on user's Application Data. If 
WindowViewer is running as a service or 
in a console session, the application is 
copied to "All Users" Application Data 
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Language Switching for a Managed InTouch 
Application

For managed InTouch applications, certain language switching 
functionality is handled by the ArchestrA IDE instead of the InTouch 
HMI.

Use the ArchestrA IDE to:

• Export and import graphic text for translation. 

• Configure the language used by the managed application.

For more information, see the Application Server User’s Guide, 
Chapter 12 Working with Languages.

Adding Files for a Managed InTouch Application
Using WindowMaker you can add files to a managed InTouch 
application so that they are deployed and available at run time.

To add files to a managed InTouch application

1 Open the managed InTouch application in WindowMaker.

2 On the File menu, click Open Application Folder. The standard 
Windows Explorer window appears showing the InTouch 
application folder on the Galaxy Repository node.

3 Add new files and folders to the InTouch application folder.

4 Close the Explorer window.



Associating All Galaxy Graphics in an InTouchViewApp45

InTouch HMI and ArchestrA Integration Guide

Associating All Galaxy Graphics in an 
InTouchViewApp

Associating all Galaxy graphics with an InTouchViewApp template 
enables deployed and published InTouch applications to execute “show 
graphic” requests made of any graphic in the Galaxy without having to 
embed them in the application.

• The ShowGraphic() function uses the graphic as a parameter. 
Associating all Galaxy graphics ensures that the graphic is 
deployed and available at run time whether or not it is referenced 
by InTouchViewApp. 

• Associating all Galaxy graphics ensures that template symbols 
referenced by the ShowGraphic() function are deployed and 
available at run time.

Note:  The term “graphic” includes any symbol or client control present 
in the Graphic Toolbox, and any symbols owned or inherited by 
templates and instances.

For more information about associating all Galaxy graphics with an 
InTouchViewApp, see the Application Server User’s Guide, Chapter 6, 
“Deploying and Running an Application”.

Access the “Include all Galaxy graphics” option through the 
InTouchViewApp right-click context menu. 

To include all Galaxy graphics with your InTouchViewApp 
template

1 Right-click the InTouchViewApp template you wish to configure. 
The InTouchViewApp context menu appears.

2 Select the Associate Galaxy Graphics menu item. The Associate 
Galaxy Graphics dialog box appears.

When the Associate Galaxy Graphics dialog appears, the 
$InTouchViewApp template is checked out.

If the $InTouchViewApp template is not yet initialized or checked 
out, the Include all Galaxy graphics with this application check 
box is not available.
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3 Click the check box and click OK. A status box displays check in 
progress. 

If an InTouchViewApp instance is deployed when you attempt to 
modify the Include all Galaxy graphics setting, you will see an 
information message to undeploy all deployed instances.
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Chapter 3

Using ArchestrA Symbols in
WindowMaker

You can use ArchestrA Symbols created with the ArchestrA Symbol 
Editor in your managed or 0-IDE InTouch applications. You can also 
add ArchestrA symbols directly from WindowMaker’s ArchestrA 
Graphic Toolbox. For more information about working with ArchestrA 
and Situational Awareness Level symbols, see the Creating and 
Managing ArchestrA Graphics User’s Guide or WindowMaker help.

ArchestrA IDE InTouch WindowMaker

Managed 
InTouch 

Applications

InTouchViewApp
Automation
Template

Manages

ArchestrA Symbol 
Editor

InTouch WindowViewer

Provides 
ArchestrA 
Symbols

Provides
ArchestrA

Symbol Functionality

Test Application

Templates and 
Instances

0-IDE InTouch 
Applications

Managed 
InTouch 

Applications

ArchestrA Graphic Toolbox

0-IDE InTouch 
Applications



48  Chapter 3  Using ArchestrA Symbols in WindowMaker

InTouch HMI and ArchestrA Integration Guide

You can:

• Embed ArchestrA Symbols into an InTouch window.

• Drag and drop ArchestrA Symbols directly from the ArchestrA 
Graphics Toolbox into an InTouch window. 

• Resize embedded ArchestrA Symbols. 

• Add a limited number of InTouch animations to ArchestrA 
Symbols.

• Configure the custom properties of embedded ArchestrA Symbols.

• Start the ArchestrA Symbol Editor.

• Test the ArchestrA Symbols in WindowViewer. 

• Create a new Instance of the AutomationObject that hosts the 
embedded ArchestrA Symbol.

Embedding ArchestrA Symbols into an InTouch 
Window

You can embed an ArchestrA Symbol into InTouch windows of your 
managed InTouch application.

The ArchestrA Symbol can be part of:

• The Graphic Toolbox.

• An ArchestrA object template.

• An ArchestrA object instance.

The ArchestrA Symbols that can be embedded include symbols whose 
elements have Element Styles applied to them and Symbol Wizards 
created using the Symbol Wizard Editor.

You cannot embed an ArchestrA Symbol into the windows of 
stand-alone InTouch applications. You can publish a managed 
InTouch application containing ArchestrA Symbols in the published 
application. However, you cannot add new ArchestrA Symbols or edit 
existing symbols in an application that has been published.
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Embedding ArchestrA Symbols from Automation 
Templates

You can embed an ArchestrA Symbol from an Automation template 
that hosts ArchestrA Symbols. At the same time, a new derived 
instance of the selected template is created.

For information about creating a new instance based on an ArchestrA 
Symbol already on the InTouch window, see "Testing ArchestrA 
Symbols in WindowViewer" on page 67.

To embed an ArchestrA Symbol from an Automation 
template

1 Open WindowMaker.

2 On the Edit menu, click Embed ArchestrA Symbol. The Galaxy 
Browser dialog box appears. 

3 Click the Template Toolbox icon. The Template Toolbox list 
appears on the left.

4 Select the template that contains the ArchestrA Symbol you want 
to embed. The ArchestrA Symbols contained in the selected 
template appear on the right.

5 Select the ArchestrA Symbol you want to embed and click OK. The 
Galaxy Browser closes and the insertion icon appears if the pointer 
is over the InTouch window. 

6 Click in the InTouch window where you want to embed the 
ArchestrA Symbol. The Create Instance dialog box appears.
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7 In the Instance Name box, type a name for the instance.

8 Click OK. An instance is automatically derived from the template 
with the name you specify. The symbol is embedded into the 
InTouch window.

Embedding ArchestrA Symbols from Instances
You can embed ArchestrA Symbols from instances that have 
ArchestrA Symbols associated with them.

When you embed an ArchestrA Symbol from an instance, the symbol is 
associated with that instance.

To embed an ArchestrA Symbol from an instance

1 Open WindowMaker.

2 On the Edit menu, click Embed ArchestrA Symbol. The Galaxy 
Browser dialog box appears. 

3 Click the Instances icon. The Instances list appears on the left. 

4 Click on the instance that contains the ArchestrA Symbol you 
want to embed. The ArchestrA Symbols associated with the 
selected instance appear on the right.
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5 Click on the ArchestrA Symbol you want to embed and click OK. 
The Galaxy Browser closes and the insertion icon appears if the 
pointer is over the InTouch window. 

6 Click in the InTouch window where you want to embed the 
ArchestrA Symbol. The symbol is embedded into the InTouch 
window.

Embedding ArchestrA Symbols from the Graphic 
Toolbox

You can embed ArchestrA Symbols from the Graphic Toolbox.

To embed an ArchestrA Symbol from the Graphic Toolbox

1 Open WindowMaker.

2 On the Edit menu, click Embed ArchestrA Symbol. The Galaxy 
Browser dialog box appears.

3 Click the Graphic Toolbox icon. The Graphic Toolbox list appears 
on the left.

4 Select the ArchestrA Symbol you want to embed and click OK. The 
insertion icon appears if the pointer is over the InTouch window. 

5 Click in the InTouch window where you want to embed the 
ArchestrA Symbol. The symbol is embedded into the InTouch 
window.
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Embedding ArchestrA Symbols with Element 
Styles Applied

You can embed ArchestrA Symbols that have Element Styles applied 
to them. An Element Style defines one or more of the fill, line, text, 
blink, and outline properties of a graphic. The visual properties 
defined in an Element Style are applied to the graphic. Element Styles 
make it easy to apply consistent styles to elements. Element Styles 
also establish visual standards for screen builders and others who 
create symbols.

An ArchestrA Symbol that has an Element Style applied to it is 
embedded into an InTouch window just like any other ArchestrA 
Symbol.

For more information about using Element Styles with ArchestrA 
Symbols, see Chapter 7, "Working with Element Styles," in the 
Creating and Managing ArchestrA Graphics User’s Guide.

Embedding Symbol Wizards
You can embed Symbol Wizards into a window of a managed InTouch 
application from the ArchestrA IDE. 

To embed a Symbol Wizard

1 Open WindowMaker and show the window that will contain the 
embedded symbol.

2 On the Edit menu, click Embed ArchestrA Symbol. The Galaxy 
Browser dialog box appears.

3 Click the Graphic Toolbox icon. The Graphic Toolbox list appears 
on the left.

4 Select the Symbol Wizard you want to embed into an application 
and click OK.

5 Click in the InTouch window where you want to embed the Symbol 
Wizard. The symbol is embedded into the InTouch window using 
its default Symbol Wizard configuration.
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Resizing Embedded ArchestrA Symbols
After embedding an ArchestrA Symbol into an InTouch window, you 
can resize it with its handles or with the width and height value entry 
as you would with any other InTouch object. 

However, if the ArchestrA Symbol contains at least one rotated 
element, you can only resize the ArchestrA Symbol proportionally.

You cannot resize the embedded ArchestrA Symbol smaller than its 
minimum size. The minimum size may be determined by the pen 
width of a contained element. 

You can reset the embedded ArchestrA Symbol to its original size 
when it was created in the ArchestrA Symbol Editor.

To resize an embedded ArchestrA Symbol

1 Select the ArchestrA Symbol so that the handles appear.

2 Do one of the following: 

• Drag the one of the handles to resize the ArchestrA Symbol to 
the new size.

• Enter width and height in the W and H boxes on the status bar. 

To resize an embedded ArchestrA Symbol to its original size

 Right-click the embedded ArchestrA Symbol you want to change to 
its original size, point to ArchestrA Graphic, and then click Symbol 
- Original Size. The embedded ArchestrA Symbol is changed to its 
original size.
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Configuring ArchestrA Symbols in 
WindowMaker

You can configure embedded ArchestrA Symbols in WindowMaker by:

• Standard editing, such as copying, cutting, pasting, duplicating, 
resizing, moving, and deleting. 

• Setting up WindowMaker animation links.

• Connecting an ArchestrA Symbol with InTouch tags.

• Selecting an alternate instance of the same parent.

• Selecting an alternate symbol of the same instance.

• Enabling or disabling dynamic size propagation.

Configuring WindowMaker Animation Links of an 
ArchestrA Symbol

You configure WindowMaker animation links of an embedded 
ArchestrA Symbol in the same way as any other InTouch object. You 
can only configure animation links that are external to the embedded 
ArchestrA Symbol, such as:

• Object size

• Object location

• Visibility

• Enablement

The animation links configured in WindowMaker are independent 
from those configured in the ArchestrA Symbol Editor. They do not 
inherit the settings of the ArchestrA Symbol and take precedence 
when run in WindowViewer. 
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To configure WindowMaker animation links of an embedded 
ArchestrA Symbol

1 Select the embedded ArchestrA Symbol. 

2 On the Special menu, click Animation Links. The Animation Links 
dialog box appears.

3 Make any changes as you would to any other InTouch object.

4 Click OK. 
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Connecting ArchestrA Symbols to InTouch Tags 
You can connect ArchestrA Symbols to InTouch tags by overriding the 
custom properties of an embedded ArchestrA Symbol. 

Custom properties expose the properties of an ArchestrA Symbol to 
InTouch. Custom properties may or may not be used internally by the 
animations of the ArchestrA Symbol.

When you embed an ArchestrA Symbol into an InTouch window, the 
references in the animation links are converted, as shown in the 
following table:

For more information about custom properties, see the Creating and 
Managing ArchestrA Graphics User’s Guide.

ArchestrA Symbol Embedded ArchestrA Symbol

Object.Extension galaxy:Object.Extension

intouch:Tagname Tagname

ArchestrA Symbol Editor

InTouch WindowMaker

Symbol1

CustomProperty3

Animation

Element1

Symbol1

CustomProperty3

Animation

Element1

tag1

tag2

tag3

InTouch Tags

Uses InTouch
Tag as Reference

CustomProperty2

CustomProperty1

Embed ArchestrA Symbol

SYMBOL4
SYMBOL3

SYMBOL2

CustomProperty2

CustomProperty1

Connecting ArchestrA Symbols with InTouch Tags
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You can select InTouch tags directly from the Galaxy Browser when 
working within the animation editor or the script editor. When 
invoked from either of those editors, the Galaxy Browser lists all 
InTouchViewApp instances for the current Galaxy, and lists all 
InTouch tags and dot fields for the selected InTouchViewApp instance.

For more information about using the Galaxy Browser to select 
InTouch tags, see the Creating and Managing ArchestrA Graphics 
User’s Guide.

To connect an ArchestrA Symbol to an InTouch tag

1 Right-click the embedded ArchestrA Symbol in the InTouch 
window, point to ArchestrA Graphic, and then click Edit Custom 
Properties. The Edit Custom Properties dialog box appears.

2 Select the custom property you want to connect to an InTouch tag. 
The configuration for the selected custom property appears in the 
right pane.

3 In the Default Value box, do one of the following:

• Type the name of the InTouch tag.

• Click the browse button and select a tag from the Select Tag 
dialog box.

4 To restore the original value of the custom property, click Restore.

5 Click OK. Any animation in the ArchestrA Symbol that is 
configured with the selected custom property now uses the 
InTouch tag value during processing.
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Example of Connecting ArchestrA Symbols to 
InTouch Tags 

This example shows you how to connect a tank symbol with a percent 
vertical fill animation created by the ArchestrA Symbol Editor to an 
InTouch tag. 

You do this in three main steps:

• Create a sample Tank as an ArchestrA Symbol.

• Create the InTouch application.

• Derive and view the sample tank in WindowViewer.

For more details on the individual steps, see the Creating and 
Managing ArchestrA Graphics User’s Guide.

To create a sample Tank as ArchestrA Symbol

1 In the IDE, create a new symbol called “Tank” and open it in the 
ArchestrA Symbol Editor.

2 Paste a rectangle on the canvas. Change its appearance as needed. 

3 Create a colored polygon element that represents a cutout of the 
tank to show the tank level.

4 Click on the canvas. On the Special menu, click Custom 
Properties. The Edit Custom Properties dialog box appears. 

5 Add a custom property called Level.



Configuring ArchestrA Symbols in WindowMaker59

InTouch HMI and ArchestrA Integration Guide

6 Configure the property details. Do the following: 

• In the Data Type list, click Float.

• In the Default Value box, type 0.

7 Click OK.

8 Double-click on the polygon element that represents the tank level. 
The Edit Animations dialog box appears.

9 Add a % Vertical Fill animation.

10 In the Analog box in the right pane, type the name of the custom 
property. In this example, it is Level.

11 Click OK to close the Edit Animations dialog box.

12 Click Close and Save to close the ArchestrA Symbol Editor. 

To create the InTouch application

1 In the ArchestrA IDE, create a new managed InTouch application. 
For more information, see "Creating a Managed InTouch 
Application" on page 33.

2 Open the managed InTouch application in WindowMaker.
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3 Create a new window called TankDisplay. 

4 Open the Tagname Dictionary and create a new real InTouch tag 
named TankLevel.

5 Click the Embed ArchestrA Symbol icon. The Galaxy Browser 
dialog box appears.

6 Select the Tank symbol and click OK.

7 Click in the window at the new location to embed the symbol. The 
Tank symbol is embedded into the window.

8 Right-click the embedded ArchestrA Symbol, point to ArchestrA 
Graphic “Tank”, and then click Edit Custom Properties. The Edit 
Custom Properties dialog box appears.

9 Select the custom property Level.

10 In the Default Value box, type TankLevel. You can also click the 
ellipsis button to browse for TankLevel using the Select Tag dialog 
box. 
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11 Click OK.

12 Paste a slider on the window and configure it with the local 
InTouch tag TankLevel.

13 Save the changes and close WindowMaker. The managed InTouch 
application is automatically checked in. 

To derive and test the sample tank

1 In the ArchestrA IDE, derive an instance of the managed InTouch 
application and deploy it together with a WinPlatform and a 
ViewEngine instance. 

2 Open the InTouch Application Manager and start the listed 
application in WindowViewer. The tank and the slider appear on 
the window in WindowViewer.

3 You can move the slider to change the tank level. 

Selecting Alternate Instances from the Same 
Parent

You can redirect all references in the ArchestrA Symbol to an 
alternate instance. The appearance of the ArchestrA Symbol does not 
change, except possibly for its size, as it is not possible to edit inherited 
ArchestrA Symbols.

You cannot use this function with ArchestrA Symbols that originate 
from the Graphic Toolbox, as they are not associated with any object.
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To select an alternate instance from the same parent

1 Right-click the embedded ArchestrA Symbol, point to ArchestrA 
Graphic, and then click Select Alternate Instance. The Galaxy 
Browser dialog box appears. It shows all other instances that have 
the same parent.

2 Select an alternate instance from the list and click OK. The 
references of the ArchestrA Symbol are updated to point at the 
new alternate instance.

Selecting Alternate Symbols of the Same 
Instance

You can replace an embedded ArchestrA Symbol with another 
ArchestrA Symbol belonging to the same instance. 

You cannot use this function with ArchestrA Symbols that originate 
from the Graphic Toolbox, as they are not associated with any object.

To select an alternate ArchestrA Symbol from the same 
instance

1 Right-click the embedded ArchestrA Symbol, point to ArchestrA 
Graphic, and then click Select Alternate Symbol. The Galaxy 
Browser dialog box appears. 

2 Select an alternate symbol in the right pane and click OK. 
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3 If the alternate symbol is a different size than the original symbol, 
a message appears prompting if you want to keep the size of the 
currently embedded ArchestrA Symbol. Do any of the following:

• Click Yes to keep the current size of the selected ArchestrA 
Symbol. 

• Click No to update the size of the selected ArchestrA Symbol to 
the size of the new ArchestrA Symbol.

In both cases, the embedded ArchestrA Symbol is updated with the 
new alternate ArchestrA Symbol.

Substituting Strings in ArchestrA Symbols
You can substitute all strings in an embedded ArchestrA Symbol with 
alternate strings. 

To substitute all strings in an embedded ArchestrA Symbol

1 Select the embedded ArchestrA Symbol. 

2 On the Special menu, point to Substitute, and then click 
Substitute Strings. The Substitute Strings dialog box appears. 

3 Type new strings in the corresponding boxes and click OK. The 
strings in the embedded ArchestrA Symbol are substituted by the 
new alternate strings.

Substituting References in ArchestrA Symbols
You can substitute all references in an embedded ArchestrA Symbol 
with alternate references. 

To substitute all references in an embedded ArchestrA 
Symbol

1 Select the embedded ArchestrA Symbol. 

2 On the Special menu, click Substitute Tags. The Substitute Tags 
dialog box appears. 

3 Type new references in the corresponding boxes and click OK. The 
references in the embedded ArchestrA Symbol are substituted by 
the new alternate references.
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Enabling or Disabling Dynamic Size Change 
Propagation of Embedded ArchestrA Symbols

You can enable or disable the dynamic size change propagation of 
embedded ArchestrA Symbols. 

If the dynamic size change propagation is enabled, any change to the 
absolute anchor point position of the source symbol:

• Leaves the anchor points of its embedded symbols unchanged.

• Moves the embedded symbol position accordingly.

If the dynamic size change propagation is disabled, any change to the 
absolute anchor point position of the source symbol:

• Moves the anchor points of its embedded symbols accordingly.

• Leaves the embedded symbol position unchanged.

For more information about dynamic size propagation, see the 
Creating and Managing ArchestrA Graphics User’s Guide.

To enable or disable dynamic size change propagation of an 
embedded symbol

 Right-click the embedded ArchestrA Symbol, point to ArchestrA 
Graphic, and then check or uncheck Dynamic Size Change. 

Editing ArchestrA Symbols in the ArchestrA 
Symbol Editor

You can edit embedded ArchestrA Symbols using the ArchestrA 
Symbol Editor that is integrated in the ArchestrA IDE. You do this by:

1 Opening the embedded ArchestrA Symbol in ArchestrA Symbol 
Editor, modifying the symbol, and then saving it. The ArchestrA 
Symbol is updated in the template, instance or in the Graphic 
Toolbox. 
For more information, see "Editing an Embedded ArchestrA 
Symbol" on page 65.

2 Accepting the changes in WindowMaker by clicking on the Symbol 
Changed icon in the right bottom corner of the status bar. The 
changes are then propagated to WindowMaker.
For more information, see "Accepting Symbol Changes in 
WindowMaker" on page 66.
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Editing an Embedded ArchestrA Symbol
You can easily edit an embedded ArchestrA Symbol from within 
InTouch WindowMaker. 

If the source symbol or its embedded symbols are used by other 
managed InTouch applications, the changes are propagated to the 
embedded symbols and the InTouch applications.

Any changes you make to the ArchestrA Symbol are not propagated to 
the embedded ArchestrA Symbols automatically. For more 
information, see "Accepting Symbol Changes in WindowMaker" on 
page 66.

To edit embedded ArchestrA Symbols using the ArchestrA 
Symbol Editor

1 Right-click the embedded ArchestrA Symbol, point to ArchestrA 
Graphic, and then click Edit Symbol. The ArchestrA Symbol 
Editor with the ArchestrA Symbol appears.

2 Edit the ArchestrA Symbol. For more information, see the Creating 
and Managing ArchestrA Graphics User’s Guide.

Editing an ArchestrA Symbol includes applying an Element Style 
to the symbol. For more information about using Element Styles, 
see Chapter 7, "Working with Element Styles," in the Creating and 
Managing ArchestrA Graphics User’s Guide.

3 Click Close and Save. The changes are saved and the ArchestrA 
Symbol Editor closes.

4 If the ArchestrA object is hosted by an instance or template, save 
and close the object editor in the IDE.
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Accepting Symbol Changes in WindowMaker
If an ArchestrA Symbol changes and you are currently using it in an 
InTouch window in WindowMaker, you can immediately accept the 
change in WindowMaker.

If you do not accept the change immediately, the symbol is updated in 
WindowMaker when the window is closed and opened again.

The symbol is also updated if you switch to WindowViewer to test the 
application or if you open the application in WindowViewer on a target 
node.

To immediately accept symbol changes in WindowMaker

 For opened InTouch windows that contain embedded ArchestrA 
Symbols, do one of the following: 

• Double-click the Symbol Changed icon in the bottom right 
corner of the status bar. 

• Close the InTouch window containing the embedded ArchestrA 
Symbol and open it again. 

In both cases, the changes made to the ArchestrA Symbol are 
reflected in the embedded symbol in the InTouch window.

Accepting Symbol Changes in WindowViewer
If an ArchestrA Symbol changes and you are currently testing it in 
WindowViewer, you can accept the change in WindowViewer.

For more information about testing embedded ArchestrA Symbols, see 
"Testing ArchestrA Symbols in WindowViewer" on page 67.

To accept symbol changes in WindowViewer when testing

 Do one of the following:

• Fast-switch to WindowMaker and then back to WindowViewer.

• Close the InTouch window and open it again. This only works if 
the Always load windows from disk option is checked in the 
WindowViewer Properties dialog box.

In both cases, the changes made to the ArchestrA Symbol are 
reflected in the embedded ArchestrA Symbol in the InTouch 
window.
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Testing ArchestrA Symbols in WindowViewer
You can test the embedded ArchestrA Symbol in an InTouch window 
without having to derive an InTouchViewApp instance. You can test 
an embedded ArchestrA Symbol if you previously:

• Created an ArchestrA Symbol in the Graphic Toolbox, in an 
automation template or automation instance.

• Created a managed InTouch application.

Embedded the ArchestrA Symbol in the managed InTouch 
application.

To test embedded ArchestrA Symbols in WindowViewer

1 In WindowMaker, click Runtime to switch to WindowViewer. 

2 Test the animations, behavior, and appearance of the embedded 
symbol as you would in a normal run-time environment.

3 You can fast-switch back to WindowMaker to make changes to the 
way the ArchestrA Symbol is embedded.

ArchestrA Symbol Editor

WindowMaker

WindowViewer

Create 
ArchestrA 
Symbol

Embed 
ArchestrA 

Symbol into 
InTouch 
Window

Fast Switch to 
WindowViewer

Test ArchestrA 
Symbol in 

WindowViewer

Fast Switch to 
WindowMaker

Modify 
ArchestrA 

Symbol and 
Save

Accept 
Changes in 

WindowMaker 
(optional)

Developing and Testing ArchestrA Symbols
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To change and test embedded ArchestrA Symbols in 
WindowViewer

1 Make changes to the ArchestrA Symbol in the ArchestrA Symbol 
Editor.

2 Save the changes. 

If WindowViewer is open, then after a short while, a message 
appears in WindowViewer prompting you to accept the changes. 
Click Yes.

If WindowViewer is closed, then you can fast-switch from 
WindowMaker to WindowViewer to see your changes. It is faster to 
close WindowViewer and to re-open WindowViewer than to wait 
for the changes to propagate to the open WindowViewer session.

Estimating Graphic Performance
You can gauge the performance of an ArchestrA symbol at run time 
using the Graphics Performance Index (GPI).

This tool calculates the estimated call up time when the symbol you 
are building in the Symbol Editor is launched at run time. Call up time 
pertains to the interval between the user or system requesting the 
pertinent graphic to appear and the graphic appearing on the screen 
with live data. The calculation is based on contents of the symbol 
launched in the InTouch WindowViewer at run time, and on a best 
case time estimate with completed external reference subscriptions.

For more information about using GPI, see "Estimating Graphic 
Performance" from Chapter 1, "About Creating and Managing 
ArchestrA Symbols," in the Creating and Managing ArchestrA 
Graphics User’s Guide.
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Creating New Automation Instances
You can quickly create a new instance of the AutomationObject that 
hosts an embedded ArchestrA Symbol. This way, you do not need to 
switch to the ArchestrA IDE and derive an instance. 

The new instance is unassigned, so you need to assign and deploy it in 
the ArchestrA IDE before you can use it. 

You can only create new Automation instances for ArchestrA Symbols 
hosted by templates or instances. ArchestrA Symbols in the Graphic 
Toolbox do not have this functionality.

To create a new Automation instance

1 Right-click the embedded ArchestrA Symbol, point to ArchestrA 
Graphic, and then click New Instance. The Create Instance box 
dialog box appears. 

2 In the Instance Name box, type a name for the instance.

3 Click OK. An instance is automatically derived from the template 
with the name you specify.
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Chapter 4

Using Managed InTouch
Applications at Run Time

You can run managed InTouch applications on remote nodes by 
deploying InTouchViewApp instances to those nodes.

You can also deploy changes of the InTouch application and contained 
ArchestrA Symbols to these nodes and select whether to accept or 
decline the changes for each node. 
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The following graphic shows how managed InTouch applications are 
deployed to run-time nodes.
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Deploying a Managed InTouch Application
You can deploy a managed InTouch application from the ArchestrA 
IDE to the local node or a remote node. After you deploy the 
application, you can run it in WindowViewer on the remote nodes.

Deploying a InTouchViewApp Object for the First 
Time

The first time you deploy an InTouchViewApp object, the associated 
InTouch application is copied to the node of the platform that hosts the 
object. This is called the operator node.

To deploy a managed InTouch application

1 Open the ArchestrA IDE.

2 Select the instance of the InTouchViewApp for which you want to 
deploy the managed InTouch application.

3 On the Object menu, click Deploy. The Deploy dialog box appears.

4 Click OK. The complete InTouch application is copied to the 
operator node.

Deploying Changes to a Managed InTouch 
Application

You can change a managed InTouch application by: 

• Changing the references, content, or size of an ArchestrA Symbol 
that is used in a managed InTouch application.

• Changing the managed InTouch application itself by opening 
WindowMaker from the InTouchViewApp template.

In both cases, when you save the changes, the changes are propagated 
from the updated template to the derived instances. The changes are 
identified by the Pending Changes icon.

The changes are not immediately reflected in a running 
WindowViewer session. The operator of each node can select to accept 
or decline the changes. For more information, see "Accepting New 
Application Versions at the Operator Node" on page 76.
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To deploy changes to a managed InTouch application

1 Open the ArchestrA IDE.

2 Select the instance of the InTouchViewApp for which you want to 
deploy the changes of a managed InTouch application.

3 On the Object menu, click Deploy. The Deploy dialog box appears.

4 Click OK. The changes are copied to the operator node.

Starting a Managed InTouch Application
From the operator node, you can start Application Manager and select 
the managed InTouch application you want to run. 

You can also set the resolution in Application Manager to run the 
managed InTouch application in different resolutions. 

To start the managed InTouch application

1 On the node the InTouchViewApp object is deployed to, start the 
InTouch Application Manager.

2 In the application list, select the managed InTouch application you 
want to run in WindowViewer.

3 Click the WindowViewer icon. The application starts in 
WindowViewer after a short while.

To set the dynamic resolution conversion settings

1 Open the InTouch Application Manager.

2 On the Tools menu, click Node Properties. The Node Properties 
dialog box appears.

3 Click the Resolution tab. 

4 Select the Allow WindowViewer to dynamically change resolution 
check box.
If Allow WindowViewer to dynamically change resolution is 
unchecked, the managed application runs with the resolution in 
which it was developed.
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5 Configure how you want to run the application. Do any of the 
following:

• Click Use application resolution to run the managed 
application at the same resolution as it was developed in.

• Click Convert to screen video resolution to convert the 
managed application so that it can run with the screen 
resolution.

• Click Custom resolution to convert the managed application to 
a specified resolution. 

6 Click OK.

Controlling the WindowViewer Restart Wait 
Period When Deploying Managed Applications

You can control the delay that occurs before WindowViewer is 
restarted when managed applications that require a restart are 
deployed. Delays are implemented to ensure the proper operation of 
the alarm subsystem.

The WindowViewer restart delay is controlled by the following 
parameters in the win.ini file, which is located in the local 
C:\Windows folder. All parameter values are in seconds.

• ViewManagedRestartWaitPeriod=0

This parameter controls the WindowViewer restart wait period. 
The default is 0, or no wait period.

• ViewNADShutdownWaitPeriod=30

For applications managed using Network Application 
Development (NAD), this parameter controls the delay before NAD 
is shutdown. The default is 30 seconds.

• ViewNADRestartWaitPeriod=90

For applications managed using NAD, this parameter controls the 
delay before NAD is restarted. The default is 90 seconds.
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Accepting New Application Versions at the 
Operator Node

If the managed InTouch application is changed and its associated 
InTouchViewApp instance is deployed, you can select to accept or 
decline the changes at the run-time node. 

A message appears prompting you if you want to accept the changes to 
the managed InTouch application:

• When you start WindowViewer from the InTouch Application 
Manager.

• While WindowViewer is running.

Depending on the nature of the change, you may be prompted to 
restart the WindowViewer application, or just reload it. You can also 
set the behavior of WindowViewer for application changes, such as:

• How WindowViewer accepts or rejects these changes.

• How frequently WindowViewer should remind you to reload or 
restart WindowViewer when changes are pending.

To accept new application versions at the operator node

 Click Yes. The changes to the managed InTouch application are 
copied to the operator node and WindowViewer restarts or reloads.

To set the behavior of WindowViewer for application 
changes

1 Open the managed InTouch application in WindowMaker.

2 On the Special menu, point to Configure, and then click 
WindowViewer. The WindowViewer Properties dialog box 
appears. 
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3 Click the Managed Application tab. 

4 In the Change Mode area, configure how WindowViewer responds 
when changes are deployed. Do any of the following:

• Click Ignore Changes to have WindowViewer ignore any 
deployed changes. You can manually configure the 
RestartWindowViewer() and ReloadWindowViewer() script 
functions to accept the changes depending on the 
$ApplicationChanged system tag.

• Click Restart WindowViewer to have WindowViewer restart 
automatically. 

• Click Prompt user to restart WindowViewer to have 
WindowViewer prompt you to restart WindowViewer. 

• Click Load changes into WindowViewer to have 
WindowViewer load the changes automatically. 

• Click Prompt user to load changes into WindowViewer to 
have WindowViewer prompt you to load changes into 
WindowViewer. 
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5 In the Reminder Interval (sec) box, type how often, in seconds, 
the user is reminded to load or restart the changes into 
WindowViewer. This option is only available when the applicable 
change mode has been set. Set the interval to 0 to not remind the 
user again.

6 Click OK. 

To set the default behavior for WindowViewer

1 Open the managed InTouch application in WindowMaker.

2 On the Special menu, point to Configure, and then click 
WindowViewer. The WindowViewer Properties dialog box 
appears.

3 Click the Managed Application tab.

4 Click Restore Defaults. The settings are reset to their default 
values.

5 Click OK. 

Running ArchestrA Scripts in Embedded 
ArchestrA Symbols

When you run a managed InTouch application in WindowViewer, any 
ArchestrA scripts associated with elements or symbol scripts 
themselves run as expected. 

However, some scripts contained in symbols can run for a long time 
and stop you from interacting with other InTouch elements.

To prevent this, you can set a script time-out that is applicable for all 
scripts in the managed InTouch application. A script time out stops 
script execution and returns the control to the operator. 

By default, scripts time out after 5 seconds.

To set the script time-out

1 Open a managed InTouch application in WindowMaker.

2 On the Special menu, click Configure, and then WindowViewer. 
The WindowViewer Properties dialog box appears.
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3 Click the Managed Application tab. 

4 In the Script timeout (msec) box, type a value in milliseconds.

5 Click OK. 
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Deploying the InTouchViewApp Object in a 
Terminal Services Environment

You can run managed InTouch applications in a Terminal Services 
environment. The main advantage of this architecture is that you can 
run multiple InTouch applications on one computer at the same time. 

To do this, you must: 

• Use InTouch Terminal Services Edition.

• Deploy each InTouchViewApp instance with its own ViewEngine 
host, if you have several InTouchViewApplication instances on the 
terminal server node. 

• Run each managed InTouch application in its own terminal 
services client session.

Note:  Only one InTouchViewApp object needs to be deployed on the 
terminal server node to make the application available to multiple 
terminal session clients. There is no need to deploy a separate 
InTouchViewApp object on the terminal server node for each client that 
will use the application.

Galaxy and Development Node

WindowMaker

Terminal Server

ArchestrA
IDE

InTouch 
(Terminal 
Services)

Client1 Client2

ArchestrA 
Platform

WindowViewer running 
InTouchViewApp1
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Edit

InTouchViewApp1

$InTouchViewApp1
$InTouchViewApp2

InTouchViewApp2

VisualizationVisualization

Derive

Managed InTouch Applications
in a Terminal Services Environment
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